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Introduction

Thank you for purchasing the D16 Digital Mix Matrix from Cadac 
Electronics Plc. 

Cadac is  renowned for supplying arguably the highest quality audio 
mixing consoles for the world-wide professional audio industry for 
over 36 years. In all these years the driving force behind the com-
pany’s research and development program has been to strive for a 
product that not only provides the exact functionality required but 
also exceptional audio performance and reliability. This can be 
attested throughout the world, with many hundreds of Cadac con-
soles working day-in day-out in many of the world’s premier venues 
and tours.

The company’s ethos is no different when it comes to digital tech-
nology. Many years of research and development programs have 
gone into the digital technology now found within the D16. It was 
Cadac’s intention from the outset that no digital products would be 
released until their audio performance could be favourably com-
pared to the company’s renowned range of analogue products. 

This comprehensive development program has now borne fruit with 
the release of the D16 Digital Mix Matrix.

We trust that this unit will bring many years of satisfaction and thank 
you for your patronage.

                                            The Cadac Development Team.
-5 D16 Digital Mix Matrix
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Features

■ High quality 16 x 16 digital matrix.
■ Ability to configure a D16 as an input or output matrix.
■ 96kHz 24 bit sampling and Sharc DSP processing using proprie-

tary Cadac mix, EQ and Dynamics algorithms.
■ Incorporates 6 band EQ including 4 band fully parametric EQ 

modelled on the acclaimed Cadac J-Type.
■ Very low latency of 400µs analogue in to analogue out regard-

less of DSP processing.
■ High build quality with hand tuned Common Mode Rejection and 

Balanced circuitry on all I/O.
■ Integral Digital Clip Protection to maintain audio and system 

integrity.
■ Local front panel control, or remote control via USB and SAM 

running on Windows ® OS.
■ Single SAM application can provide integral control over multiple 

D16 units in addition to automated Cadac consoles.
■ MIDI input via SAM, with auto-learn facility, allowing physical 

control of D16 parameters from any external MIDI device (or 
MIDI enabled console).

■ Designed to maintain and replicate traditional Cadac perform-
ance in the digital domain.

■ Designed to exceed current EMC directives, and immune from 
receiving or transmitting radio frequency interference.

■ Ideal solution for touring or space restricted applications when 
extra channel counts or output busses are required.

■ Provides high grade digital performance for critical recording 
applications.

■ Scalable active digital splitter from 1 in 16 out (2 in 8 out etc).
■ Ideally suited for distributed multi-zone audio applications.
■ On-going development program.
■ Seamless integration with Cadac automated consoles, through 

bus link connectors.

Using the D16 User Manual

In order to obtain the most out of your D16, please read the User 
Manual carefully.

Prior to installing and using the D16, it is also important that you have 
read both Safety Instructions  and Important Information.

If you still have a problem that cannot be resolved by referring to this 
manual, then please contact your local CADAC distributor.

All information provided within this user manual is provided in good 
faith. CADAC follows a policy of continual product development; 
changes to equipment specification may be made without prior no-
tice.
l Mix Matrix Revision DM2005-5
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Declaration of conformity

The Directives covered by this Declaration

89/336/EEC Electromagnetic Compatibility directive, amended by 
92/31/EEC & 93/68/EEC

The Products Covered by this Declaration

D16 Digital Mix Matrix

The Basis on which Conformity is being Declared

The products identified above comply with the requirements of the 
above EU Directives by meeting the following standards:

BS EN 55103-1:1997 Electromagnetic compatibility - Product
family standard for audio, video, audio-
visual and entertainment lighting control
apparatus for professional use.
Part 1 – Emissions

BS EN 55103-2:1997 Electromagnetic Compatibility - Product 
family standard for audio, video, audio-
visual and entertainment lighting control
apparatus for professional use.
Part 2 – Immunity

BS EN 60065:1998 Audio, Video and similar electronic appa-
ratus. Safety requirements.

Signed:............................

Authority: General Manager

Date: 24 January 2005
-5 D16 Digital Mix Matrix
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1 Important Safety Instructions

1.1 Mains Cable

The supplied IEC mains cable must be correctly terminated before 
use. Use only an approved AC plug or power distribution device. 
Safety ground must be connected at all times.

Safety Earth = Green/Yellow
Live = Brown
Neutral = Blue

1.2 Changing the fuse

To avoid the risk of fire, use only the recommended fuse type as in-
dicated in this manual and on the D16. Do not short-circuit the fuse 
holder.

Before changing the fuse, always switch off the unit and remove the 
IEC mains cable.

To replace a fuse, remove the fuse holder (located adjacent to the 
IEC mains socket) by turning the fuse holder anti-clockwise.

Replace the blown fuse with an identical type. See Fuse Type below 
for further details.

1.3 Fuse Type

90v - 250v: 2A Type T

FIG 1-1.  Remove the fuse holder

Fuse holder

Fuse holder
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1.4 Servicing

There are no serviceable parts contained within the D16. Refer all 
servicing to your CADAC distributor.

1.5 Do not remove any covers

Within the D16 are areas where high and dangerous voltages are 
present. Removing any covers will invalidate warranty.

1.6 Safety checklist

■ Install in accordance with CADAC’s instructions.
■ Do not place the apparatus on an unstable or uneven surface.
■ Do not insert objects through any apertures. Doing so could 

result in damage to the unit or electric shock.
■ Do not use this apparatus near water.
■ Do not block any of the ventilation openings
■ Do not install near any heat sources.
■ Do not install near naked flames.
■ Protect the mains cable from being stressed or pinched.
■ For optimum results, do not use the D16 on the same electrical 

circuit as industrial equipment, such as motors, stage machinery 
or any other equipment that causes noise or switching transients 
on the mains circuit.

■ Unplug this apparatus during lightning storms or when unused 
for long periods of time.

■ Adjust only those controls that are covered by the operating 
instructions.

■ Use only the mains lead provided with the D16. Other leads may 
not have sufficient current rating.

■ Do not operate this unit with the cover removed.
■ Unplug the unit before cleaning.
l Mix Matrix Revision DM2005-5
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2 Important information

2.1 Unpacking

The packaging for the D16 is designed to safely contain and protect 
the D16 from the rigours and stresses usually experienced during in-
ternational shipment. Specially designed mouldings cushion and 
support the D16.

The D16 packaging contains:

■ 1 x D16
■ 1 x set of rack mounting ears + fitting screws
■ 1 x IEC mains lead (either fitted with UK or US style plug, or 

unwired depending on country of use)
■ 1 x USB cable (2m length)
■ 1 x operations manual
■ 1 x SAM Sound Automation Manager

2.2 Operational considerations

AC mains voltage

The D16 is intended for use throughout the world and therefore the 
internal power supply allows operation through the following AC 
mains voltages: 90v - 250v AC, 50/60Hz

AC mains connection

The rear panel of the D16 houses the AC mains inlet on an IEC style 
connector. The mains cable supplied with the D16 is also fitted with 
a moulded IEC connector. Excluding UK and USA models, no plug 
has been fitted to this mains lead, therefore this will need to be wired 
(see 1.1 Mains Cable). Obtain professional advice from a qualified 
electrician if unsure.

2.3 Cleaning

Before cleaning the D16, make sure the unit is switched off and the 
mains plug is removed from the socket.

Only use a mildly damp cloth to clean the D16. Never use any do-
mestic or commercial cleaning agents as these can cause damage 
to external surfaces and components.

2.4 Installation

When fixing the D16 into any 19” rack mount frame, take into ac-
count the stresses that can be exerted on the rack ears if they are 
the only means of support. Damage to the chassis could especially 
occur during transportation if the D16 is not supported on rails within 
a flight case. CADAC strongly recommends that as well as fixing the 
D16 to the frame via the rack ears, support rails also be employed.
-5 D16 Digital Mix Matrix
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3 The D16 Digital Mix Matrix

3.1   D16 Front Panel

1. Channel Number
2. Signal Overload Indicator
3. Signal Present Indicator
4. PFL Switch
5. Mute Switch
6. Headphone Socket
7. Headphone Level Control
8. 40x2 Menu Display
9. Menu Buttons
10.Set rotary encoder with push switch
11.Remote Indicator
12.USB Indicator
13.Mains ON Indicator
14.Mains Switch

6          7   8  9                                5  10   11  12

1    2  3                           4                14   13

FIG 3-1.  D16 Front panel layout
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3.2 D16 Rear panel

1. Mains Inlet
2. Mains Fuse
3. Ground Stud
4. Bus Output Connector
5. PFL Bus Connector (PFL control via SAM)
6. Analogue Line Level Input Connectors
7. Analogue Line Level Output Connectors
8. Parallel Input Connector
9. Remote Control Connector
10.USB Port

1              2    3          6        8                        9          10

4                              57

FIG 3-2.  D16 Rear panel layout
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3.3 Connecting up your D16

3.3.1 Mains Power

Make sure that your IEC power connector is wired correctly (see 1.1 
Mains Cable).

Fit the IEC lead to the rear power connector on the D16, making 
sure that it is fitted securely and the lead is stress free.

3.3.2 Ground Stud

The D16 has been designed to fully comply and exceed current 
EMC directives (immunity from electro-magnetic radiation and radio 
frequency interference). However, for optimum performance, it is 
also important to take into consideration the entire audio system 
and minimize the potential for excessive ground loops occurring 
between equipment and interference being induced within audio 
cabling.

A Ground Stud is provided on the rear panel of the D16 to allow 
connection to other audio devices in order to minimize ground 
potentials, as well as providing a connection point for the use of 
Parallel Earth Conductors, which can reduce induced noise within 
audio cabling by up to 80% if used correctly.

System wiring and grounding techniques fall well outside the scope 
of this User Manual, however, there are a number of reference 
sources available. More information on this topic can also be found 
on the CADAC Sound Check Zone at www.cadac-sound.com.

3.3.3 Audio Connections

Inputs

Connect the line level input cables to the respective XLR-3F con-
nectors on the rear panel of the D16, making sure that all the con-
nectors mate securely. In addition to the XLR connectors, a 37-way 
D-Sub connector (female) is also provided. This is wired in parallel 
to the XLR inputs.

Analogue Outputs

Channel line level outputs are available on XLR-3M connectors, 
while an additional line level bus output connector is available on a 
37-way D-sub connector (female). For D-sub wiring details, please 
see Appendices - Connector Layouts.

NOTE: All line level outputs are balanced and designed to 
drive over long cable lengths in excess of 500m, with little deg-
radation in audio performance. These outputs are level com-
pensated, whereby if one leg is shorted to ground, the other 
leg will double its amplitude to compensate.
-5 D16 Digital Mix Matrix
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3.4 Power On

Power on the D16 using the main power switch located on the front 
panel. The red power indicator located on the front panel will illumi-
nate to indicate when the D16 is operating.

NOTE: The D16 performs an initialisation and calibration phase 
when power is applied. During this time all outputs will remain 
muted. This function lasts for approximately 30 seconds.

NOTE: The D16 retains the latest settings of every parameter in 
non-volatile memory. Therefore these settings are not lost 
when the unit is not powered and are automatically recalled 
when power is applied.

NOTE REGARDING THE USE OF I/O CABLES: The overall per-
formance of the entire audio system is determined by the qual-
ity of the audio cables used. Make sure that line level audio 
cables are of high quality with proper shielding in place. When 
using multi-core snake, CADAC recommends the use of indi-
vidually shielded twisted pairs with an overall braided shield.

3.4.1 Channel LED indicators

LEDs are provided on each channel for visual indication of signal 
present and signal overload conditions.

The red Signal Overload LED illuminates when the channel signal 
level reaches +18dBu, giving ample warning of a potential overload 
condition with at least 3dB of headroom to spare. The signal is 
sourced pre MUTE / post HPF.

The green Signal Present LED illuminates when the audio signal on 
that specific channel exceeds -36dBu. The signal is sourced pre 
MUTE / post HPF.

3.4.2 PFL switch

An internal PFL facility is provided and can be accessed via the front 
panel headphone socket. PFL selection is via 16 PFL switches locat-
ed on the front panel. These switches illuminate when enabled. 

NOTE: Two independent PFL outputs are provided on the D16. 
The first is controlled via the front panel PFL switches and 
feeds the front panel headphone socket. The second is control-
led via the PFL switches within Cadac’s Sound Automation 
Manager software package and feeds the rear panel 9-way D-
sub PFL Bus connector.

3.4.3 MUTE switch

16 MUTE switches are also provided to allow the operator to mute 
any of the 16 channels. When enabled, these switches are illuminat-
ed red.
l Mix Matrix Revision DM2005-5
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3.5 Headphones

A headphone socket is provided on the D16 front panel. The head-
phone output is sourced from the PFL bus, therefore any PFL selec-
tion can be monitored on the headphones.

Control of the headphone output is via the headphone level control, 
located to the left of the Menu display.

The headphone circuitry is designed to drive a load of 150 ohms up-
wards. Headphone impedances below 150 ohms can still be used, 
however, the audio level will be reduced.

NOTE: Headphone output level is displayed within the D16 Root 
Menu - see 4.1 Menu Display Overview.
-5 D16 Digital Mix Matrix
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4 Menu Navigation

Control of all remaining parameters is managed through a menu 
structure using the Menu display (40x2 character display), Set con-
trol and the five Menu buttons. It is via this Menu display that the 
D16 can be configured for standalone operation.

The five Menu buttons located beneath the Menu display enable 
you to navigate your way though the D16 control system. Labels will 
appear above these buttons offering various options depending on 
what parameters are being controlled.

Common labels that occur throughout the menu structure are:

Prev : Previous.  Returns to the previous screen of the selected 
group.

Next : Next.Accesses the next screen of the selected group.

Return :  Steps back one level in the menu structure.
-5 D16 Digital Mix Matrix
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4.1 Menu Display Overview.

NOTE: After a period of time (see 4.3.3 BackLight) the Menu dis-
play on the D16 returns to standby mode, whereby the back-
light switches off. Press any Menu button to reactivate the 
screen to where it left off.

The Root Menu display (see below) allows the operator to view the 
current PFL level setting (0%=full attenuation). This value may be 
adjusted via the Level control on the front panel irrespective of any 
active Menu display.

Beneath the PFL display are five soft keys labelling the control 
groups System , Options , Levels, Faders  and Edit . These groups 
can be accessed by selecting the appropriate Menu button located 
beneath each label.

System : Provides service information relating to the D16 including 
Firmware revision, communications address and operating temper-
ature.

Options:  Allows configuration of the PFL bus, Menu display back-
light and compressor Pre/Post EQ

Levels:  Provides input and main output level indicators in addition 
to compression reduction meters.

Faders:  Provides options for setting input/output, and master fader 
levels.

Edit:   Enables control of input gain, send levels, equaliser and 
dynamics on a per channel basis.

  PFL Vol: 57%     
  System      Options         Levels           Faders        Edit
l Mix Matrix Revision DM2005-5
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4.2 System Menu

■ Select System  from the Root menu to enter the System menu.

Use Next  and Prev  to scroll through the System menu and Return  
for the Root menu.

■ From the Root Menu press System

4.2.1 Firmware revision

Provides information on the installed D16 Firmware revision, plus 
date and time of installation.

■ Press Next

4.2.2 Unique Serial Number

Provides the unique serial number of the D16

■ Press Next

  Ver: 1.00     Date:    Sep 01 2004    11:55:34
  Prev            Next                                               Return

              Unit Serial Number   =    50103                                                                   
Prev            Next                                               Return
-5 D16 Digital Mix Matrix
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4.2.3 Box Temperature

Provides information on the internal operating temperature of the 
D16 (in degrees centigrade).

■ Press Next

4.2.4 D16 Communications Address

Provides the Communications Address of this particular D16 
device. The Communications Address is only of importance when 
operating single or multiple (to a maximum of eight) D16s via 
Cadac’s Sound Automation Manager (SAM) .

To set the Communications address, rotate the Set control to a 
unique address value. If using multiple D16 units in conjuction with 
SAM then the Communications Addresses should increment 
accordingly:

D16 #1 : Communications Address = 1
D16 #2 : Communications Address = 2
D16 #3 : Communications Address = 3
                              
                              
D16 #8 : Communications Address = 8

For additional information in configuring SAM, see 5.4 Configuring 
SamSetup.

■ Press Return  to return to the Root menu.

                                                      Box Temperature = 40�       
Prev            Next                                                 Return

                                       Communications  Address = 1       
Prev            Next                                                 Return

&RPPV#$GGUHVV
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4.3 Options Menu

■ Select Options  from the Root menu to enter the Options menu.
■ Use Next  and Prev  to scroll through the Options menu and 

Return  for the Root menu.
■ From the Root menu press Options

4.3.1 PFL Hold

Displays whether PFL Hold  is on  or off . This affects the operation 
of the 16 front panel PFL switches. 

■ To enable or disable the PFL Hold  function press the Menu but-
ton labelled toggle .

When PFL Hold  is set to on,  one or more PFL switches can be 
selected enabling multiple PFL signals into the PFL headphone 
mix.

When PFL Hold  is set to off , the PFL switches operate in an inter-
locking or exclusive mode whereby selection of a PFL switch can-
cels any previous PFL selection.

■ Press Next

4.3.2 Signal Path Configuration

This is a system-wide setting allowing the D16 to be configured 
either as an input or output matrix. DSP1/ DSP2 provide input 
matrix signal paths with full dynamics / EQ prior to the matrix sends, 
while DSP3 / DSP4 provide output matrix signal paths with full 
dynamics / EQ post matrix sends. The Signal paths available are:

DSP1: Input>Delay>Gate>Compressor>EQ>Mix>Output
DSP2: Input>Delay>Gate>EQ>Compressor>Mix>Output
DSP3: Input>Gate>Mix>Compressor>EQ>Delay>Output
DSP4: Input>Gate>Mix>EQ>Compressor>Delay>Output

                                          PFL Hold           off
  Prev            Next                                 Toggle      Return

 DSP1:          In>Del>Gate>Comp>EQ>Mix>Out    Sel 
  Prev            Next                              Load        Return
-5 D16 Digital Mix Matrix
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■ Use the Set rotary control to select the desired signal path for 
the D16.

NOTE: If the DSP signal path displayed within the menu differs 
to that currently set within the D16 an asterix will be displayed 
next to the Load button. i.e. Load*

■ Press Load*  to reconfigure the D16 signal path. 

NOTE: When reconfiguring the D16, please be aware that the 
DSP within the unit will be re-initialised. This means that it will 
interrupt any audio flow passing through the unit.

■ The message DSP System Intialised  will momentarily be dis-
played to confirm the process has been completed. 

■ Press Next

4.3.3 BackLight

■ Use the Set rotary control to select a value from 125 to 1000. 
This determines the length of time that the BackLite is active.

A setting of 1000 equates to approximately 40 seconds.

NOTE:  Rotate the Set control slowly for fine control and fast 
for coarse control of the BackLite value.

■ Press Return  to return to the Root menu.

                                       BackLite                         1000
  Prev            Next                              Toggle      Return
l Mix Matrix Revision DM2005-5
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4.4 Levels Menu

■ Select Levels  from the Root menu to view input channel, main 
output and gain reduction levels.

■ From the Root menu press Levels

The top row of the window displays either the input level, main out-
put signal strength or channel gain reduction as an accurate 
numeric value (to a tenth of a dB) on a per channel basis. This is fol-
lowed by 16 bargraph meters sourced either pre input fader, post 
main output fader, or displaying gain reduction within the compres-
sor sections.

■ To switch between inputs, outputs and gain reduction meters, 
press the centre Menu button (in the case above labelled Input ).

The menu button labelled Range  enables the meter scaling of the 
16 bargraphs to be altered. Full scale equates to either 0dBu or 
+18dBu as indicated on the display. Pressing Range  toggles 
between these two modes.

NOTE: The Range function only applies when metering Inputs 
or Outputs. Range does not function when metering gain 
reduction.

  Chan 1: <-60.0dB
  Prev            Next           Input          Range      Return

  Out 1: >-60.0dB
  Prev            Next          Outputs        Range     Return

  Comp 1: >-00.0dB
  Prev            Next          CompRdx       Range     Return
-5 D16 Digital Mix Matrix
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NOTE: These meters are limited in their resolution and there-
fore only increment in 6dB steps. They are intended to simply 
provide visual indication of signal level strength rather than 
being used as a measuring tool.

■ Use Prev  and Next  to select the desired input channel (1 to 16),  
main output (1 to 16) or gain reduction meter.

■ Press Return  to return to the Root menu.
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4.5 Faders Menu

Select Faders from the Root menu to enable control over all input, 
output and master fader levels.

To return any time to the Root menu, press Return .

■ From the Root menu, press faders.

The Faders menu provides control over input, main output and 
group master fader levels.

NOTE: Group Master fader levels can be equated to DC or VCA 
Master fader levels as found on traditional analogue audio mix-
ing consoles.

Select whether input, output or master faders are to be controlled by 
pressing the Menu button labelled either Input, Output or Master. If 
outputs are to be controlled, then the active output channel will be 
displayed. See figure below.

  Chan 1: -86.0dB              ________________    -0dB
  Prev            Next               Input         Set All       Return

  Chan 1: -86.0dB            ________________       -0dB
  Prev            Next             Output         Set All      Return
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but-
4.5.1 Set One  Fader Level

Select whether input, output or master faders are to be controlled by 
pressing the Menu button labelled either Input, Output or Master.

Make sure that the Faders Menu is set for individual control. This 
mode is selected by pressing the Menu button labelled Set One . If 
this Menu button is already displaying Set All , then the Fader Menu 

is already in the required mode1.

■ Select the desired channel by pressing the Prev  and Next  but-
tons.

Rotate the Set control to select the desired fader level in 0.1dB 
steps. All fader scales are from –86.0dB to +10dB. The updated 
fader level is graphically displayed.

  Chan 1: -86.0dB             ________________      -0dB
  Prev            Next             Input         Set One      Return

1. As a general principle, the button legend tells you what it is going to do when a 
ton is pressed.

  Chan 1: -86.0dB              ________________    -0dB
  Prev            Next             Input          Set All     Return

  Chan 4: -86.0dB             _________________    -0dB
  Prev            Next             Input            Set All      Return
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To return to the Root Menu, press Return .

4.5.2 Set All  Fader Levels

Select which faders are to be controlled by pressing the Menu but-
ton labelled either Input, Output or Master.

This mode is selected by pressing the Menu button labelled Set All . 
If this menu is displaying Set One , then the Fader Menu is already 
in the required mode.

Rotate the Set control to select the desired fader bank levels in 
0.1dB steps. All fader scales are from –86.0dB to +10.0dB. The 
updated fader levels are graphically displayed. 

  Chan 4: 0.0dB                ___-____________       -0dB
  Prev            Next             Input            Set All      Return

  Chan 4: -86.0dB             ________________    -0dB
  Prev            Next             Input            Set All      Return

  Chan 4: -86.0dB             ________________    -0dB
  Prev            Next             Input         Set One     Return
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To return to the Root  Menu, press Return.

4.5.3 Master Fader

The Master Fader control  screen works in conjunction with Cadacs’ 
Sound Automation Manager (SAM) computer software package. 
Via SAM, it is possible to independently assign input and output fad-
ers to be part of a DC or VCA style group. There are in total 16 
master group faders within the D16.

NOTE: It is not possible to assign input and output faders to a 
DC or VCA style group via the D16 front panel. 

Operation of the master faders via the D16 front panel is identical to 
that of the input and output faders.

NOTE: If an F16 DC Master Assignment Interface Unit is 
directly connected to the D16 it will overide any changes made 
to master fader levels set via the front panel.

The F16 interfaces with all Cadac consoles, plus a selection of con-
soles from third party console manufacturers, and enables fader 
group assignment within the D16 (or multiple D16s) to become inte-
gral to the console’s DC or VCA grouping. The DC or VCA group 
master faders on the console can then directly control the assigned 
fader levels within the D16(s). 

  Chan 4: 0.0dB                - - - - - - - - - - - - - - - -    -0dB
  Prev            Next             Input         Set One      Return
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4.6 Edit Menu

■ Select Edit from the Root menu to control all channel parame-
ters.

To return any time to the Root menu press Return .

■ From the Root menu press Edit to enter the Edit Menu.

4.6.1 Edit Menu Controls

■ To scroll through the 16 input channels use the Channel  – or +  
menu buttons. 

[ – Chan + ]

To scroll through the 16 input channels, use the Channel – or +  
menu buttons, see diagram above. The selected channel number is 
indicated within the parenthesis, example [ – Chan 16+ ]

[ – Param + ]

To scroll through the all the parameters available within the selected 
channel, use the Parameter – or +  menu buttons, see diagram 
above.

Set Control

Rotating the Set Control allows numeric values to be altered within 
appropriate parameters.

Pressing the Set Control allows static parameters to be toggled. For 
example Delay On or Off.

                                   Low Pass Freq (off)
     [ – Chan 1 +]                     [ – Param +]            Return
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4.6.2 Channel Reset

The D16 provides the ability to return any channel to its default 
state. This can be of use when reconfiguring specific channels 
within the D16, or wishing to return a channel to a known status.

■ To return a particular channel to the system default status, first 
select the desired channel by using the Chan + and Chan -  
Menu buttons.

■ Simultaneously press the Para + and Para - Menu buttons.

■ The D16 will ask for confirmation, see above.

■ Select Yes  to confirm or No to cancel operation.

If Yes is selected then a confirmation is displayed before the win-
dow returning to standby mode.

4.6.3 System Reset

The D16 is provided with the facility to return all parameters on all 
channels to a default state. This is of particular use when reconfig-
uring the D16 for another application.

■ To return the D16 to its default state simultaneously press the 
Chan +  and Chan –  menu buttons.

■ Select Yes  to confirm or No to cancel operation.

If Yes is selected, then a confirmation is displayed before the win-
dow returns to standby mode.

  Clear Channel 1 to default values?
                                                                  Yes            No

  Clear All Channels to default values?
                                                                  Yes            No
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4.6.4 Channel Parameters

Each channel on the D16 is provided with the following parameters:

■ Mic Gain (when used in conjunction with Cadac’s M16 Remote 
Controlled Microphone Amplifier)

■ Input Trim and Polarity Invert
■ High and Low Pass Filters
■ 4-band Fully Parametric Equaliser.
■ 16 individual sends to the Main outputs, source Pre or Post fader
■ Gate
■ Compressor
■ Delay

The following parameters are available to the operator via the Edit  
menu.

4.7 EQ Section - High and Low Pass Filters

4.7.1 Low Pass Freq

On / Off selection
The low pass filter can be toggled on  or off  by pushing the Set con-
trol located to the right of the Menu display.

4.7.2 Frequency selection

The low pass filter frequency can be selected in 0.1kHz increments 
by rotating the Set control. Available frequency range is from 
1.0kHz to 35.0kHz with a slope of 12db/octave.

NOTE:  Rotate the Set control slowly for fine control and fast 
for coarse control of the frequency value.

4.7.3 High Pass Freq

On / Off selection.
The high pass filter can be toggled on  or off  by pushing the Set 
control located to the right of the Menu display.

4.7.4 Frequency selection

The high pass filter frequency can be selected in 0.4Hz increments 
by rotating the Set control. Available frequency range is from 14.0 
Hz to 400.0 Hz with a slope of 12db/octave.

NOTE:  Rotate the Set control slowly for fine control and fast 
for coarse control of the frequency value.
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4.8 EQ-section - 4-Band Fully Parametric Equaliser

The D16 equaliser has been developed to emulate Cadac’s classic 
equalisers as found on the J and R-Type consoles. 

NOTE: EQ band selection.
Each equaliser band (LF, LMF, HMF, HF) can be independently 
toggled on or off by pushing the Set control located to the right 
of the Menu display. This will activate the EQ band’s Fre-
quency, Gain and Q functions.

4.8.1 LF Freq

Frequency selection
The LF frequency can be selected by rotating the Set control. Avail-
able frequency range is from 20.0Hz to 200.0Hz.

4.8.2 LF Gain

Gain selection
The LF gain can be selected in 0.1dB increments by rotating the 
Set  control. Available cut/boost range is from -18.0dB to 18.0dB.

4.8.3 LF   Q    

Q factor
The LF Q factor can be selected in 0.1 increments by rotating the 
Set  control. Available Q factor range is from 1.0 to 3.0.

4.8.4 LMF Freq 

Frequency selection
The LMF frequency can be selected by rotating the Set control. 
Available frequency range is from 60.0Hz to 600.0Hz.

4.8.5 LMF Gain 

Gain selection
The LMF gain can be selected in 0.1dB increments by rotating the 
Set  control. Available cut/boost range is from -18.0dB to 18.0dB.

4.8.6 LMF   Q  

Q factor
The LMF Q factor can be selected in 0.1 increments by rotating the 
Set  control. Available Q factor range is from 1.0 to 3.0.

4.8.7 HMF Freq

Frequency selection
The HMF frequency can be selected by rotating the Set control. 
Available frequency range is from 400.0Hz to 4.0kHz.
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4.8.8 HMF Gain 

Gain selection
The HMF gain can be selected in 0.1dB increments by rotating the 
Set control. Available cut/boost range is from -18.0dB to 18.0dB.

4.8.9 HMF   Q

Q factor
The HMF Q factor can be selected in 0.1 increments by rotating the 
Set control. Available Q factor range is from 1.0 to 3.0.

4.8.10 HF Freq

Frequency selection
The HF frequency can be selected by rotating the Set control. Avail-
able frequency range is from 1.5kHz to 15.0kHz.

4.8.11 HF Gain

Gain selection
The HF gain can be selected in 0.1dB increments by rotating the 
Set control. Available cut/boost range is from -18.0dB to 18.0dB.

4.8.12 HF   Q    

Q factor.
The HF Q factor can be selected in 0.1 increments by rotating the 
Set control. Available Q factor range is from 1.0 to 3.0.

4.9 Sends to Main outputs

Each input channel is provided with 16 variable gain matrix sends 
that route to the 16 Main outputs. Each send has its own dedicated 
on/off switch and send level.

4.9.1 Send   1 

Source selection

Send 1 can be sourced Pre EQ, Post EQ or Post Fader by pushing 
the Set control located to the right of the Menu display.

Pushing Set scrolls through the following options:

Display Function

Pre off Pre EQ Off
Pre on Pre EQ On
Pst off Post EQ Off
Pst on Post EQ On
Fdr off Post Fader Off
Fdr on Post Fader On

NOTE: Any of the Off states (Pre off, Pst off and Fdr off) can be 
selected to switch the send off.
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Send 1 level can be controlled in 0.1dB increments, from –65.0dB 
to +10dB by rotating the Set  control.

Press Param +  to scroll through the remaining Sends. Repeat as 
above.

4.10 Dynamics Section.

The D16 comes equipped with a comprehensive dynamics sections 
on every input channel, providing Gate and  Compression algo-
rithms. All dynamics parameters can be accessed through the 
Menu display.

4.10.1 Gate

The D16 Gate comprises of the following parameters: Attack, 
Release, Threshold and Hold and is sourced post input Trim.

NOTE: Gate on/off selection.
The Gate can be toggled on or off by pushing the Set control 
located to the right of the Menu display. The Gate can be acti-
vated within any of its four screens.

4.10.2 Gate Attack 

The Gate Attack time can be controlled from 0.1ms to 250ms by 
rotating the Set control. 

4.10.3 Gate Release

The Gate Release time can be controlled from 50.0 ms to 2.6s by 
rotating the Set control. 

4.10.4 Gate Threshold

The Gate Threshold level can be controlled in 0.1dB steps from -
70dB to +23dB by rotating the Set control.

4.10.5 Gate Hold 

The Gate Hold time can be controlled from 25ms to 4s by rotating 
the Set control. 
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4.11 Compressor

The D16 Compressor section comprises of the following parame-
ters: Attack, Release, Threshold, Hold, Ratio, Make Up Gain and 
Knee. The compressor is sourced either PreEQ or PostEQ depend-
ant on how the compressor is globally configured.

NOTE: Compressor  on/off selection.
The Compressor can be toggled on or off by pushing the Set 
control located to the right of the Menu display. The Compres-
sor can be activated within any of the Release, Hold, Ratio and 
Gain screens.

NOTE: Selection of whether the compressor is located pre or 
post equaliser is a global control. See Options Menu, 4.3 
Options Menu .

4.11.1 Compressor Attack

The Compressor Attack time can be controlled from 0.1ms to 
250ms by rotating the Set control.

Pushing the Set control toggles the mode of compression between 
Peak and RMS. RMS (Root Mean Square) compression provides a 
more consistent and overall compression as it is not instantly 
responding to any peaks in the audio material. Peak compression 
on the other hand is more responsive to transients. 

4.11.2 Compressor Release 

The Compressor Release time can be controlled from 50.0 ms to 
2.6s by rotating the Set control. 

4.11.3 Compressor Threshold

The Compressor Threshold level can be controlled in 0.1dB steps 
from -70dB to +23dB by rotating the Set control.

Pushing the Set control applies different compression curves at the 
point of threshold. These are known as Hard and Soft knee and 
pressing Set toggles between these two.

With a Soft knee, the compression starts gradually as the signal 
exceeds the threshold, whereas with a Hard knee the change is 
less gradual.

4.11.4 Compressor Hold          

The Compressor Hold time can be controlled from 25ms to 4s by 
rotating the Set control. 

4.11.5 Compressor Ratio        

The Compressor Ratio can be controlled in 0.1 increments from 1:1 
to 20:1 by rotating the Set control.
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4.11.6 Compressor Gain       

The Compressor Make Up Gain can be controlled in 0.1dB incre-
ments from 0.0dB to +30.0dB.

4.12 Input Gain Control

4.12.1 Input Trim 

The Input Trim feature adjusts the input sensitivity to  the channel in 
0.1dB steps by rotating the Set control. Available gain range is from 
–10.0dB to +10dB.

Pushing the Set control toggles the polarity of the input signal in the 
digital domain.

4.12.2 Mic Gain (M16) 2

4.13 Delay

Delay  

Each channel on the D16 can be assigned individual delays up to a 
maximum of 400ms per channel by rotating the Set control.

on / off selection

The Delay can be toggled on or off by pushing the Set control 
located to the right of the Menu display.

2. M16 Mic gain control is no longer implemented. This menu item shall be removed in a future software release.
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5 Automated Operation using Cadac 
Sound Automation Manager

The D16 is designed to fully integrate with CADAC’s advanced Win-
dows based Sound Automation Manager (SAM). Automation is now 
an integral part of modern sound design, requiring a sophisticated 
range of tools to cater for the ever-increasing complexity of live 
sound applications. Under SAM, every D16 parameter can be con-
trolled, allowing complex cue changes to be performed. In addition, 
all D16 parameters can be mapped to dedicated external hardware 
controllers (via MIDI) to provide the added benefit of tactile control 
for those engineers who find working with a computer mouse un-
comfortable.

5.1 Computer Requirements

To run the Sound Automation Manager the following minimum spec-
ifications are required:

■ 2GHz Celeron or Pentium 4
■ 512Mbyte RAM
■ 40Gbyte Hard disc
■ Graphics 1024x768 (16-bit colour)
■ USB Port
■ 10/100 BaseT Ethernet (RJ45)
■ Windows ® 2000 or XP

5.2 Installing SAM into a Windows ® OS computer

The Sound Automation Manager software is supplied on CD-ROM. 
To install SAM place CD in the CD-ROM drive on your computer 
and follow the steps below:

■ In the Windows Start menu, click on Run….A dialog box opens, 
see below. In the Open box, type D:\setup.exe and click OK. If 
your CD-ROM drive has a different drive letter assigned to it then 
substitute this letter for D.

■ Press OK

NOTE: Prior to in-
stalling the software, 
make sure the D16 is 
not connected to the 
computer.
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■ Click Next >

■ Enter Name and Company. Do not alter the serial number.

■ Click on Next >
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■ Choose the destination folder where SAM is to be installed. The 
default destination folder is C:\Program Files\Cadac. 

■ Click on Next >

■ Select Program Folder (the default Program Folder is Sound 
Automation Manager)

■ Click on Next >
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■ SAM will then be installed.
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■ Once completed click on Finish

You have now installed Cadac’s Sound Automation Manager soft-
ware.
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5.3 Connecting the PC to the D16

■ Make sure that the D16 is powered down before making any 
data connections.

■ Connect the supplied USB cable to an available USB port on the 
computer. Only one end of the cable is designed to connect 
directly to the computer. Connect the other end to the USB con-
nector provided on the rear panel of the D16.

■ Power up the D16.

Installing the USB driver

NOTE: It is important that the Cadac USB driver is installed, 
otherwise the computer will not be able to communicate with 
the D16. Those customers already using USB drivers for other 
Cadac products may need to uprade their installation if this 
disc carries a later version. 

If not previously installed then the computer will not have the 
required Cadac USB driver. Windows® will therefore automatically 
open the Found New Hardware Wizard.

■ Click on “No, not this time ” then click Next>
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■ Click on “install from a list or a specific location (Advanced) ” 
and then Next>

■ Select “Search ” and then enable checkbox “Include this loca-
tion in the search: ”

■ Click on Browse and select C:\Program Files\Cadac\USB-
Driver

■ Click Next>
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SB 
d 
■ The Wizard will install the USB Driver for the Cadac - D16 Digital 

Mix Matrix.1

■ Upon completion click Finish

You have now installed the Cadac USB Driver.

1. It is likely that Windows will raise a message box to inform you that the Cadac U
driver has not been digitally signed by Microsoft. This is perfectly acceptable an
you may proceed to install this driver.
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5.4 Configuring SamSetup

NOTE: If your computer is running a firewall you may be 
warned that the Cadac program is trying to access the internet. 
This is because of the communications method employed, and 
the program is not actually accessing the internet.  You should 
therefore instruct the firewall to grant access permission to the 
program. 

After you have installed the Sound Automaton Manager it will 
appear as a new section in the Program folder of the Windows ® 
Start  menu. One of the entries in this section is Sam Configura-
tion . Click on Sam Configuration to run the SamSetup utility.

The latest version of SamSetup (SAM Version 1.08 build 3 or later) 
allows both single and multiple D16s to be configured in a simple 
and uniform way. The recomended setup procedure is the same for 
both configurations. However to provide backwards compatibility for 
customers already using D16s in the field, the previous setup pro-
cedures for the D16 and D16 Output Matrix have also been 
retained.

For those using SamSetup for the first time, or for new sound 
designs,  please use the following simplified method which allows 
from 1 x D16 to a maximum of 8 x D16s to be configured within 
SAM. 
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5.4.1 Single/Multiple D16 Set up 

Select Console > Setup Consoles from the SamSetup window.

■ Click your mouse over the Console 1 check box to activate the 
‘console’ you wish to configure.

■ From the Type pull down menu select Multiple D16s
■ Set Frames  to the number of D16s that are to be controlled 

within SAM. 
      Frames = 1 for a single D16, 
      Frames = 2 for two D16s, 
      Frames = 3 for three D16s etc.
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■ Click on button Set Port  to configure which communications port 
is to be used.

■ Click checkbox to enable Use USB Port (SamUsb)
■ Set Unit ID  to 1.

NOTE: For Single D16 operation.
Make sure that the D16 Unit ID (set via the D16 front panel 
menu, see 4.2.4 D16 Communications Address ) is identical to 
that set within SamSetup.

NOTE: For Multiple D16 operation.
Make sure that the first unit’s Communication Address (set via 
the D16 front panel menu, see 4.2.4 D16 Communications 
Address ) is set to 1 and the subsequent addresses on other 
D16s  increment consecutively. SamSetup only requires the 
first D16’s Communications Address to be set, and will auto-
matically assign consecutive addresses to any additional D16s 
specified in the Frames field.

Example: 

D16 #1: Frame 1, Unit ID 1
D16 #2: Frame 2, Unit ID 2
D16 #3: Frame 3, Unit ID 3

D16 #8: Frame 8, Unit ID8
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■ Click on OK to close Network Settings window.
■ Click on OK to close Setup Consoles window

Now you need to configure SamSetup to recognise the D16(s) and 
whether they are input or output matrices.

■ From the main SamSetup window, make sure that Console 1  is 
selected within the Console window. This is located in the top 
right-hand corner of the SamSetup window. It should display 
Multiple D16s .

■ Choose the Current Frame  from the Frame Configuration win-
dow for the D16 that you want to configure. For example: if Cur-
rent Frame is set to 1 then this relates to D16 #1 ( when Unit ID 
is set to 1).

 
■ From the Fixed Layouts  pull-down menu select whether the 

D16 is configured as an input or output matrix. This is deter-
mined by the internal DSP signal path setting within the D16 
itself. See 4.3.2 Signal Path Configuration

■ Once the Fixed Layout is selected click on the Set Layout  but-
ton. This action automatically configures the frame to represent 
the D16 configuration you have specified. 
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The example above shows that D16 #1 is configured to be an input matrix.

If multiple D16s are to be used then the process needs to be 
repeated for the remaining D16s in the system:

Example: To configure D16 #3.

■ Select the Current Frame  within the Frame Configuration win-
dow to 3.

 
■ From the Fixed Layouts  pull-down menu select whether the 

D16 is configured as an input or output matrix. 

■ Once the Fixed Layout is selected click on the Set Layout  button 
to configure D16 #3.

■ Repeat this process until all D16s within the system are correctly 
configured.
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The example above shows that D16 #3 is configured to be an output matrix.

If the Computer and D16 are communicating correctly two green 
ticks will appear in the Console window. The first (a ghost icon) indi-
cates active communication with the D16 USB driver, and the sec-
ond (a console icon) indicates active communication with the D16. 

Once complete, either:

■ Select File>Save  to save settings or 
■ Select File>Save and Exit  to save the settings and exit the 

SamSetup utility.
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5.4.2 D16 operation in conjunction with an automated Cadac console

SAM provides the ability to automate two independent Cadac con-
soles within the same automation system. For example simulta-
neous control of both a J-Type and an F-Type console. This facility 
can also be extended to the D16, therefore allowing control of both 
a Cadac console and single, or multiple D16s within the same auto-
mation package. 

The setup procedure is identical  to that described in chapter 5.4.1 
with the addition of configuring both Console 1  and Console 2  
within the SamSetup> Setup Consoles  window.

Example:

Console 1 = Multi-frame J-Type
Console 2 = Multiple D16s

Further information specifically related to configuring and mapping 
automated Cadac consoles (such as the J-Type and F-Type) can be 
found in the SAM User Guide.

NOTE: SamSetup, within version 1.08 build 3 and later, oper-
ates in such a way that it only communicates with whichever 
console is currently selected (for example: Console 1). By 
doing this it avoids any potential for corrupting configuration 
data that may already be stored for the other console (i.e. Con-
sole 2 in this example.)   

The above example shows a single frame J-Type configured as 
Console 1  with three D16s configured within Console 2 .
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6 Getting up and running

CADAC’s Sound Automation Manager is a feature packed live auto-
mation system that has evolved over many years. Consequently, it 
is not possible to detail all the features and facilities that SAM pro-
vides within this user manual. Such information can be obtained 
from the SAM Installation & User Manual. SAM also provides a use-
ful and comprehensive on-line help assistant, accessed via the help 
menu.

Information contained within the D16 User Manual allows the first 
time SAM operator to get the system up and running. For further de-
tailed information, please refer to the SAM Installation & User Man-
ual.

6.1 Running SAM with a D16

Make sure that the D16 is connected to the computer and that the 
D16 is powered on. You will see the USB LED indicator on the D16 
front panel illuminate.

NOTE: Before loading SAM for the first time, it is necessary to 
run the SamSet utility. If the automation system is not config-
ured via SamSetup to know which hardware it is meant to con-
trol, then the automation software will not operate correctly. 
See 5.4 Configuring SamSetup

Click on the START menu button located at the left hand side of the 
Windows task bar. Select All Programs , then click on Sound Auto-
mation Manager > Sound Automation Manager .

SAM will open and automatically load the SampleShow show file. 
Under certain conditions, SAM may report a “Mapping Conflict ”. 
Please refer to the SAM User Guide for further explanation pertain-
ing to this message. 

The first thing to do is to make sure that communications between 
computer and D16 are enabled. Look at the Console Status window 
which will be exhibiting blue crosses. See figure below.

This is called the off-line mode and allows you to create Cues on a 
computer that is not connected to the D16 (i.e. setting up the show 
from home/office or hotel) 
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To enable communications: 

■ Select the Comms  pull down menu
■ Select Open/Close Ports 
■ Tick the Online  checkbox relating to the D16(s)
■ Press the D16’s associated Set Port button located on the right 

hand side of the window.

Check that the USB port is enabled and that the Unit ID is identical 
to the Communications Address set on the first D16.  See 4.2.4 D16 
Communications Address

■ Press OK to exit the Network Settings window
■ Press OK to exit the Setup Communications Ports window

Confirm that communication between the D16 and SAM is now 
active by looking at the Console Status window where you should 
see that two of the blue crosses have now changed to green ticks 
(see below). 

If either, or both, icons display a red cross, then this indicates that 
there is a fault in communications. If this is the case, please refer to 
5.4 Configuring SamSetup.
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6.1.1 Loading the first CUE

■ To load the first cue from the Sample Show, press the PageDn 
button on your computer (this is a short-cut key). An alternative 
way of recalling a cue is to go to the Cue window (to open this 
window select View>Cue from the pull down menu), left-click 
with the mouse to select the desired cue number (1.00, 2.00 
etc.), then right-click and select Recall Cue .

Hint: PageDn loads the next cue, while PgUp loads the previous 
cue.

You will now see channel strips appear within the first frame window 
and these represent the D16 channels. If no window opens then fol-
low the process below:

■ Left-click over the Console View button on the task bar. 

This will open the Console View window, where it is possible to 
enable or disable views of both console modules and faders. 
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■ From the Console View window, left-click over both the Module 1 
and Frame 1 icons to bring the D16 windows (for D16 #1) into 
view.

Configurations of either D16 input or output matrices result in two 
separate windows being displayed for each D16. The first repre-
sents the channel strips (known as the Module Frame ), while the 
second is a fader window (known as the Fader Frame .)
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This Module Frame window is configured as a D16 input matrix. 
Use the scroll bar located at the bottom of the window to scroll 
across all 16 channels. A further 16 blank panels can also be 
viewed. These positions are only used when the D16 is configured 
as an output matrix.

NOTE: The resolution of the computer display will determine 
how much detail can be viewed at any one time. With higher 
resolution screens (such as 1400x1050 or higher) it is possible 
to view 16 channels at a time.
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The fader view operates in a similar manner to the Module Frame 
window. The Fader Frame window enables access to all 16 input 
and 16 output faders by using the scroll bar located at the bottom of 
the window. 

Input Faders come with white fader caps. 
Output faders come with red fader caps.
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When configured as an output matrix the first 16 module positions 
within the module frame window consist of the D16 input stage and 
matrix send controls. Whilst the second set of 16 module positions 
provide the output dynamics, delay and EQ controls which are 
sourced post matrix sends. Use the scroll bar located at the bottom 
of the module frame window to scroll between input and output 
channels.

The fader view operates in a similar manner to the Module Frame 
window. The Fader Frame window enables access to all 16 input 
and 16 output faders by using the scroll bar located at the bottom of 
the window. 

Hint: The main display window on SAM is divided into four quad-
rants. To quickly move from one quadrant to another, press Alt+1, 
Alt+2, Alt+3 or Alt+4. See Birds-eye Toolbar in the SAM User 
Guide. 
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6.1.2 Changing D16 module Parameters

■ To change any of the D16 switch parameters within the Module 
Frame window, left-click the mouse over the switch on the 
desired channel. The new status of the switch will be displayed, 
although more detailed information can be viewed within the 
module detail window. 

Example: Switch status for Matrix Send source selection.

Matrix Send 15  sourced Post Fader (button colour:gold)  

Matrix Send 15  sourced Pre Fader (button colour: amber)

Matrix Send 15 sourced Post EQ (button colour: yellow)
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■ To change any of the rotary values double-click over the module 
(making sure not to click over a switch). This will bring up a 
Detail View  (see below) which provides a greater degree of 
module information and allows all parameters to be changed.

Holding the mouse pointer over any of the potentiometers will open 
a “ToolTip”, showing the current value of the potentiometer. 

■ To change the value of the potentiometer left-click the mouse 
over the pot and drag the mouse. Dragging the mouse up or to 
the left will increase the value, and down or to the right will 
decrease the value.

■ By double-clicking over a potentiometer it is possible to directly 
enter a numeric value.

■ To change any of the switches within the detail window, place the 
mouse pointer over the desired switch and left-click. The new 
status of the switch will be displayed.
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6.1.3 Changing D16 Fader Parameters

■ To change any of the D16 fader values via SAM, from the Fader 
Frame window double-click over the desired fader. This will bring 
up a detail window, which allows all parameters to be changed.

■ To change any of the PFL and MUTE switches, place the mouse 
pointer over the desired switch and left-click. The new status of 
the switch will be displayed as per traditional physical back lit 
switches.

■ To change the DC Group assign click the up or down arrow 
switches on the fader module. There are a total of 16 available 
DC Groups and these are indicicated within the display as hexi-
decimal (base 16) numbers: 0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F.

NOTE: It is also possible to control the PFL, MUTE and DC 
Group Assign switches directly from the Fader Frame window 
by left-clicking the mouse pointer over the desired switch.   

■ Clicking and dragging the fader cap up or down will vary the 
fader value accordingly.

NOTE: Graphics for the ‘7-segment Display’ and associated 
selection switches for DC Group assignments operate in con-
junction with either the Master fader controls (operated via the 
D16 front panel menu, see 4.5.3 Master Fader ) or the Cadac F16 
DC Master Assignment Interface Unit.

NOTE: SAM is provided with extensive Short-Cut Keys. See 
SAM User Guide for details.
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6.1.4 Global Update of parameters

NOTE: Global Update is a very powerful editing feature with which 
you may extensive changes to your show file. The section below is 
a simple introduction, it is suggested that reference is also made to 
the full detailed explanation within the SAM User Guide .

The Global Update feature within SAM allows selection of various 
parameters over multiple channels simultaneously. This, therefore, 
is a highly useful feature, when wanting to set the D16 into an initial 
state.

This facility is available for both channel strips and faders.

Updating a switch and potentiometer

Select which channel you want to work with. The method of select-
ing channels is identical to other Windows applications. Pressing 
Ctrl whilst selecting channels with a left click of the mouse will add 
individual channels to those already selected. Pressing Shift whilst 
selecting channels with a left-click of the mouse will add groups of 
channels to those already selected.

■ Right-click the mouse and click on Global Update . This will 
open the Global Update window (see below).
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■ Click over the switch you want to change until it displays the 
desired setting. Double-click over the potentiometer that needs 
changing and input the desired value, in dB, in the Set Pot Value 
window. Then click on Apply Selected .

Entering a numerical value for Aux16.

■ To action the update process, click on the Update button within 
the Global Update window.
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6.1.5 Updating a fader level

This operation is identical to using Global Update on channel 
parameters. The only difference is that it is possible to update the 
fader value by dragging the fader cap up and down.
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6.1.6 Target Edit

The Target Edit feature within SAM allows simulteneous control of 
single, multiple (or even differing parameters) over single/multiple 
channels, all directly via the Frame Views within SAM. This is a 
highly useful feature, especially when operating SAM via a Tablet 
PC as the operator does not have the benefit of using a mouse to 
access the Detail View windows.

Example: Controlling a D16 output matrix via a wireless Tablet PC.

One application that makes good use of the Target Edit feature is 
operating the D16 as an output matrix, being sourced by the output 
busses of a console. The D16 provides output managment function-
ality between the console and power amplifiers (or between the 
console and dedicated speaker processors).

When configuring and tuning the show, the sound designer is now 
in a position to make use of a wireless Tablet PC to control the D16. 
This provides both the freedom to move around the auditorium lis-
tening to the overall balance of the system and the ability to control 
any level, EQ, dynamics or delay parameters where appropriate.

Operating via a “Virtual Desktop” package1, the Tablet PC links 
back wirelessly to the main PC (which is hardwired to the D16) run-
ning the main SAM program. The Tablet PC then mirrors exactly 
what is displayed on the main PC’s screen, whilst also allowing the 
sound designer full access to all SAM parameters.

By mapping the Jog Dial control on the Tablet PC directly to the Tar-
get Edit feature, it is possible for the sound designer to quickly 
select which parameter is to be controlled and then, by nudging the 
Jog Dial, simply and accurately control D16 parameters (i.e. incre-
ment and decrement gain for example). Target Edit therefore 
enables the sound designer to concentrate on the critical aspects of 
the audio system rather than the mental and physical process of 
altering potentiometer values via stylus or mouse.

It is possible to control all switch states directly via the Frame Views 
as mentioned in  6.1.2 Changing D16 module Parameters.

1. While using a “Virtual Desktop” system may seem unnecessarily complex (wirel
linking directly to the D16 would save an extra PC!) it provides inherent control 
backup if the wireless link is lost for any reason during a performance. The hard
wired PC is still controlling the D16 and may be stepped through programmed c
by an assstant operator.
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6.1.7 Opening Target Edit

The function of Target Edit is to allow the operator to control any 
fader or potentiometer parameter directly from the main Module and 
Fader Frames within SAM. Therefore avoiding the need to  delve 
further into the system (i.e. opening Detail Views) in order to 
change these parameters.

NOTE: The following instructions apply to using a mouse. 
However, if using a stylus then the equivalent to a right-click of 
the mouse is to briefly hold the stylus pen to the screen.  

■ Move the mouse pointer over either the Module Frame or Fader 
Frame. 

■ Right-click the mouse and click on Target Edit . This will open 
the Target Edit window.
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6.1.8 Using Target Edit to alter single potentiometer values.

■ Open the Target Edit  window.

■ Select which potentiometer you want to alter and left-click the 
mouse over it. The selected control will then be contained within 
a red box.

■ The Target Edit window displays the Module  name, Control  
name and current Value .

Channel 4, Auxiliary 9 with a current Control Value of -65dB

■ Left-click on the - and + buttons to alter the potentiometer Value, 
or press the + or - keys on your keyboard.

NOTE: These would be the keys that the previously mentioned 
Jog Dial control found on Tablet PCs would be mapped to.

■ Check the Fine Adjustment  box to enable parameter values to 
change at a finer resolution.

■ To insert a specific value, left-click the mouse within the Value  
field and enter the new value.

■ Left-click on the left/right arrows to change Module  (channel) 
number.

■ The Minimum button automatically reverts the Control Value to 
its minimum setting. 

■ The Clear All  button clears all parameters from the Target Edit 
window, leaving it blank.  
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6.1.9 Using Target Edit to alter fader values.

■ Open the Target Edit  windown.

■ Select which fader you want to alter and left-click the mouse over 
it. The fader will then be contained within a red box

■ The Target Edit window displays the Module  name, Control  
name and current Value .

Channel 5, Fader with a current Control Value of -infinity (i.e. closed)

■ Left-click on the - and + buttons to alter the fader Value .

■ Check the Fine Adjustment  box to enable parameter values to 
change at a finer resolution.

■ To insert a value, left-click the mouse within the Value  field and 
enter the new value.

■ Left-click on the left/right arrows to change Module  (channel) 
number.

■ The Minimum button automatically reverts the Control Value to 
its minimum setting. 

■ The Clear All  button clears all parameters from the Target Edit 
window, leaving it blank.  
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6.1.10 Using Target Edit to alter multiple values.

With Target Edit it is possible to select and control multiple parame-
ters simultaneously. 

Examples are:

(GLW#PXOWLSOH#SDUDPHWHUV#ZLWKLQ#D#VLQJOH#0RGXOH1
(GLW#D#VLQJOH#SDUDPHWHU#RYHU#PXOWLSOH#0RGXOHV1
(GLW#PXOWLSOH#SDUDPHWHUV#RYHU#PXOWLSOH#0RGXOHV1#

■ Open the Target Edit  window.

■ Select which parameters you want to alter and while holding 
down the Shift key, left-click the mouse over them. It is possible 
to select both potentiometers and faders. All selections will then 
be contained within red boxes.

■ If the selection encompasses multiple modules of different types, 
then the Module  field will display Multiple .

■ If the selection encompasses multiple controls of difference 
types, then the Control  field will display Multiple .

■ If the selection encompasses mutiple different values then the 
Value  field will display Multiple .

■ Left-click on the - and + buttons to alter the parameter values.
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■ Check the Fine Adjustment  box to enable parameter values to 
change at a finer resolution.

NOTE: When multiple controls of differing values are being 
adjusted (Value field displays Multiple), each parameter value 
is being adjusted relative to the number of times the - and + 
buttons are being pressed. i.e. they maintain their individual 
settings plus or minus their relative adjustment.

■ To insert a single value that will be set for all controls, left-click 
the mouse within the Value  field and enter the new value.

■ The Minimum button automatically reverts all controls to their 
minimum setting. 

■ The Clear All  button clears all parameters from the Target Edit 
window, leaving it blank.  

6.1.11 Stereo Link

A stereo link facility is provided within SAM allowing D16 channels 
to be linked if stereo sources are present, or if the D16 is configured 
to provide a stereo output for example.

It is important to note that D16 channels and D16 faders can be 
linked independently. This allows two channels to be linked for a 
stereo source for example, whilst maintaining individual control over 
left and right fader levels.

■ Move the mouse pointer over either the Module Frame or Fader 
Frame depending on which you want to stereo link. 

NOTE: Make sure that the mouse pointer is over one of the 
modules that you want to link.

■ Right-click the mouse and click on Link Left or Link Right . 

■ Choose Link Left to link the selected module with that to its left. 
Likewise choose Link Right to link with the module that is to its 
right.
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When linking channels a confirmation window will appear to warn 
that parameters within the selected module will be copied to either 
the module to the left or right.

■ Click OK to continue or Cancel  to return to the main window.  

A graphic link above the selected channels is then displayed within 
the Module View window to indicate which channels are linked.

■ Repeat this procedure where necessary for stereo linking both 
channel modules and fader modules.
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D16 Specifications

Note:  0dBu = 0.775v rms without reference to impedance. Unless otherwise stated, all specifications given below apply 
to the frequency range 20Hz to 20kHz. All noise measurements are rms, and made with a DIN audio band filter ( –3dB 
points at 22Hz and 22kHz) in circuit.

Analogue inputs
Input Impedance: 10kohm (electronically balanced)
Nominal Input Level: 0dBu
Max. Input Level: +24dBu (balanced)

+10dBu (unbalanced)
Reference: +4dBu = –20dBfs
CMRR: –85dB (50Hz - 10kHz)
A to D conversion: 24 bit 96kHz
Signal to Noise: -105dBu at zero gain
Dynamic Range: 119dB, 20Hz to 20kHz unweighted
THD: 0.008%@1kHz, 10dB gain, +4dBu
Frequency Response: 5Hz to 80kHz: ±0dB
Crosstalk: –80dB at 10kHz

Analogue Outputs
Impedance: <100 ohm (balanced)
Nominal Load Impedance: 600 ohm
Nominal Output Level: 0 dBu
Max. Output Level: +24dBu into 600 ohm
Output Balance: –65dB (50Hz - 10kHz)
D to A conversion: 24 bit 96kHz
Dynamic Range: 119dB, 20Hz to 20kHz unweighted
THD: 0.009%@1kHz, 10dB gain, +4dBu
Frequency Response: 5Hz to 65kHz: ±0dB
Crosstalk: –80dB@10kHz
Output Reference Level: +4dBu = –20dBfs

Digital Processing
Internal Sampling Frequency: 96kHz
Internal Processing: 32-bit floating point
Latency analogue in analogue out: <400µs

Line Level Gain: ±10dB Input Trim
–65 to +10dB Channel Fader
–75 to +10dB Matrix Send
–75 to +10dB Output Fader

Overall system frequency response at any analogue output: 5Hz to 45kHz (-3dB point)
Overall system noise at any analogue output: –95dBu (input and output faders@0dB)

EQ Parameters
4 band parametric
LF    20Hz to 200Hz
LMF 60Hz to 600Hz
HMF 400Hz to 4.0kHz
HF 1.5kHz to 15.0kHz
all bands ±18dB gain
Q 1.0 to 3.0

HPF 14.0Hz to 400Hz
LPF 1.0kHz to 35.0kHz
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Dynamic Parameters
Gate Threshold -70dBu to + 23dBu
Attack 100µs to 250ms
Release 50ms to 2.6s
Hold 25ms to 4s

Compressor Threshold -70dBu to +23dBu
Attack 100µs to 250ms
Release 50ms to 2.6s
Hold 25ms to 4s
Ratio 1:5:1 to 20:1
Knee Hard or Soft selectable

Peak or RMS selectable
Makeup Gain 0.0dB to +30.0dB

Delay
Adjustable DelayTime: 0ms to 400ms

Matrix Send Source Selection: Pre EQ
Post EQ (Pre Fader)
Post Fader

Memory Scenes:
Standalone: 1
Operating under SAM: unlimited

MIDI Control:
MIDI Input All D16 variables controllable in real-time, using SAM’s MIDI
 Input mapping feature
MIDI Output Complete suite of MIDI functionality from SAM

General
Power Requirements 90 – 250VAC 50/60Hz
Power Consumption 2A
Dimensions in mm (WxDxH) 430x400x3U
Unit Weight 6.5kg (14lbs)
Average Shipping Weight 10kg (22lbs)

Detailed I/O audio connection specifications
Analogue Input XLR3F, 37-way D-sub (pin-out to M16)
Analogue Output XLR3M
Bus Link Analogue Output 1 to 16 37-way D-sub* (pin-out to J-Type sub-groups)
PFL Bus 1) Local Headphones (Z=50 ohm min.) on TRS jack

2) Console – 9-way D-sub. Line level output*
(with logic line control for CADAC consoles)

* These outputs provide balanced drive with an output Z=3k6ohm, suitable to drive CADAC console virtual earth mix 
busses directly. They may be connected to high impedance (>10kohm) inputs if required, but will be subject to a small 
signal loss (–3dB).

Connection specifications
Computer Interface USB Type B downstream
Control Interface RS485 on 15-way D-sub
Power 3-pin IEC22

EMC
Complies with EN55103-1: Emissions

EN55103-2: Immunity
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Appendices

Connector wiring

D16: wiring for USB connector
3LQ#4= 12&
3LQ#5= '$7$#.
3LQ#6= '$7$#±
3LQ#7= &20021
6KHOO= &20021

'49=#ZLULQJ#IRU#480ZD\#'0VXE###########################################################
+5607;8#5HPRWH#&RQWURO#,22,
3LQV#4/</5/43= &20021
3LQ#6= '$7$#0
3LQ#44= '$7$#.
6KHOO= &20021

'49=#ZLULQJ#IRU#6:0ZD\#'0VXE#PDOH#FRQQHFWRU
+,QSXW,

3LQ#4= ,QSXW#4#$XGLR#.
3LQ#53= ,QSXW#4#$XGLR#±
3LQ#5= ,QSXW#5#$XGLR#.
3LQ#54= ,QSXW#5#$XGLR#±
3LQ#6= ,QSXW#6#$XGLR#.
3LQ#55= ,QSXW#6#$XGLR#±
3LQ#7= ,QSXW#7#$XGLR#.
3LQ#56= ,QSXW#7#$XGLR#±
3LQ#8= ,QSXW#8#$XGLR#.
3LQ#57= ,QSXW#8#$XGLR#±
3LQ#9= ,QSXW#9#$XGLR#.
3LQ#58= ,QSXW#9#$XGLR#±
3LQ#:= ,QSXW#:#$XGLR#.
3LQ#59= ,QSXW#:#$XGLR#±
3LQ#;= ,QSXW#;#$XGLR#.
3LQ#5:= ,QSXW#;#$XGLR#±
3LQ#<= ,QSXW#<#$XGLR#.
3LQ#5;= ,QSXW#<#$XGLR#±
3LQ#43= ,QSXW#43#$XGLR#.
3LQ#5<= ,QSXW#43#$XGLR#±
3LQ#44= ,QSXW#44#$XGLR#.
3LQ#63= ,QSXW#44#$XGLR#±
3LQ#45= ,QSXW#45#$XGLR#.
3LQ#64= ,QSXW#45#$XGLR#±
3LQ#46= ,QSXW#46#$XGLR#.
3LQ#65= ,QSXW#46#$XGLR#±
3LQ#47= ,QSXW#47#$XGLR#.
3LQ#66= ,QSXW#47#$XGLR#±
3LQ#48= ,QSXW#48#$XGLR#.
3LQ#67= ,QSXW#48#$XGLR#±
3LQ#49= ,QSXW#49#$XGLR#.
3LQ#68= ,QSXW#49#$XGLR#±
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'49=#ZLULQJ#IRU#6:0ZD\#'0VXE#IHPDOH#FRQQHFWRU1
+%XV#2XWSXW,

This output incorporates 3k6 mix resistors designed to connect to a 
Cadac console’s virtual earth mixing system. Note that the outputs 
are also phase reversed in relation to the Input connector.

3LQ4= $XGLR#4#±
3LQ#53= $XGLR#4.
3LQ5= $XGLR#5#±
3LQ#54= $XGLR#5.
3LQ6= $XGLR#6#±
3LQ#55= $XGLR#6.
3LQ7= $XGLR#7#±
3LQ#56= $XGLR#7.
3LQ8= $XGLR#8#±
3LQ#57= $XGLR#8.
3LQ#9= $XGLR#9#±
3LQ#58= $XGLR#9.
3LQ:= $XGLR#:#±
3LQ#59= $XGLR#:.
3LQ;= $XGLR#;#±
3LQ#5:= $XGLR#;.
3LQ<= $XGLR#<#±
3LQ#5;= $XGLR#<.
3LQ43= $XGLR#43#±
3LQ#5<= $XGLR#43.
3LQ44= $XGLR#44#±
3LQ#63= $XGLR#44.
3LQ45= $XGLR#45#±
3LQ#64= $XGLR#45.
3LQ46= $XGLR#46#±
3LQ#65= $XGLR#46.
3LQ47= $XGLR#47#±
3LQ#66= $XGLR#47.
3LQ48= $XGLR#48#±
3LQ#67= $XGLR#48.
3LQ49= $XGLR#49#±
3LQ#68= $XGLR#49.

'49#ZLULQJ#IRU#<0ZD\#'0VXE#PDOH#FRQQHFWRU
+3)/#2XW,

3LQ#9= $XGLR#.
3LQ#4= $XGLR#±
3LQ#5= 3)/BGF
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'49=#ZLULQJ#IRU#;/506)#+/LQH#/HYHO#,QSXW,
3LQ#4=#&20021
3LQ#5=#$XGLR#.
3LQ#6=#$XGLR#±

'49=#ZLULQJ#IRU#;/5060#+/LQH#/HYHO#2XWSXW,
3LQ#4=#&20021
3LQ#5=#$XGLR#.
3LQ#6=#$XGLR#±
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,PSRUWDQW#QRWHV=

$OO#&$'$&#SURGXFWV#DUH#&RPPRQ#%RQGHG1#7KLV#LV#SDUW#RI#WKH#
GHVLJQ#SURFHGXUH#WR#HQVXUH#FRPSOLDQFH#ZLWK#WKH#(XURSHDQ#
(0&'#+(OHFWUR#0DJQHWLF#&RPSOLDQFH#'LUHFWLYH,=#%6(18843604#
+(PLVVLRQV,#DQG#%6(18843605#+,PPXQLW\,1

&RPPRQ#%RQGLQJ#PHDQV#D#VLQJOH#FRQGXFWLYH#VWUXFWXUH#IRU#DOO#
UHIHUHQFH/#VLJQDO#DQG#SRZHU#UHWXUQ#FXUUHQWV1
&20021# #6DIHW\#(DUWK/#*5281'/#39/#*1'#ERQGHG#WRJHWKHU1

$OO#µ'0VXE¶#FRQQHFWRUV#XVHG#IRU#H[WHUQDO#FRQQHFWLRQV#VKRXOG#
EH#SXUFKDVHG#ZLWK#D#FRQGXFWLYH#VKHOO#DQG#WKH#FDEOH#VKLHOG#
0867#EH#ERQGHG#WR#WKH#VKHOO1##
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D16 Default Parameters

All faders = 0.0dB
All PFL = OFF
All Mutes = OFF

EQ
LP = OFF 35kHz
HP = OFF 14Hz
LF = OFF 20Hz  0.0dB  1.0Q
LMF = OFF 60Hz 0.0dB 1.0Q
HMF = OFF 400Hz 0.0dB 1.0Q
HF = OFF 1.5kHz 0.0dB 1.0Q

SENDS = All “PRE OFF” 0.0dB

GATE = OFF
Attack = 0.0ms
Release = 50.0ms
Threshold = –79.1dB
Hold = 25.0ms

COMPRESSOR = Peak, Hard, Off
Attack = 0.0ms
Release = 50.0ms
Threshold = 23.3dB
Hold = 25.0ms
Ratio = 1.0:1
Make up gain = 0.0dB

Trim = 0.0dB
Phase Invert = OFF
MIC Gain = 10.0dB PAD = OFF +48v = OFF

Delay = OFF 0.0ms
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CADAC USB ReProgramming Utility

CADAC will, from time to time, release firmware updates for the D16 
in order to improve performance and enhance facilities.

Your local CADAC distributor will keep you informed when such up-
dates are available.

The following sections explains how to install the new firmware into 
the D16 using the USB ReProgramming Utility.

Before any update can take place, it is important to make sure that 
neither SAM Configuration nor Sound Automation Manager is run-
ning on the system. If either of these applications is active, then it 
must be closed.

NOTE: Prior to updating the D16 Flash Memory with new 
firmware, it is important to make sure that ALL Windows appli-
cations are closed.

When SAM is running, it takes control of the USB port and retains 
control even when the application has been closed. It is therefore im-
portant to make sure that control over the USB is released, in order 
for the reprogramming application to operate correctly.

Releasing the SamUSB port

On the Windows taskbar, right-click on the SamUSB icon and click 
on Exit. This releases the USB Port.
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Running the Sam ReProgramming Utility

Make sure that the D16 is switched on and the USB cable is connect-
ed to both computer and D16.

■ Click on the Start button on the Windows Taskbar.
■ Select All Programs > Sound Automation Manager > USB 

ReProgramming Utility.

The reprogramming application SamFlasher will open.
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SamFlasher will interrogate the USB port and display which devices 
are attached. In this case it will be the D16.

Details of the D16 will be displayed, giving Unit ID, Unit Description, 
Unit Serial Number and currently installed firmware version.

To install the new firmware version, first highlight the unit that re-
quires updating by clicking over the Unit ID number. This will high-
light the unit and display the unit serial number within the File box.

Click on the Load File  button and select the path to allow SamFlash-
er to locate the update program.

The file will follow the naming format below and has a .bin extension:

D16_Vxxx.bin  (where xxx represents the firmware version.

NOTE: The file can either be received from your local distribu-
tor, or downloaded via the Sound Check Zone on the CADAC 
website (www.cadac-sound.com)
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Once selected, the file details will be displayed in the File box, giving 
file description, file size and date of release.

With the file location specified and the desired unit for firmware up-
date highlighted, left-click on the START button. This will initiate re-
programming of the firmware.

IMPORTANT: WHEN UPDATING FIRMWARE, DO NOT RUN ANY 
OTHER PROGRAMS, ALSO DO NOT REMOVE POWER OR ANY 
CONNECTIONS, OTHERWISE THE FIRMWARE UPDATE WILL 
BE INTERRUPTED AND THE D16 MAY NO LONGER OPERATE. 
IF THIS HAPPENS, THE UNIT WILL NEED TO BE RETURNED TO 
CADAC OR YOUR LOCAL DISTRIBUTOR.

Once the D16 has been successfully updated, the unit will reboot it-
self and after several seconds USB communications will be re-ena-
bled. SamFlasher will then display the new installed firmware 
version. 

Further confirmation can be obtained by viewing the firmware ver-
sion via the D16 front panel menu, see 4.2 System Menu.

Repeat this process for any additional D16 units.

Click OK to close the program.
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F16 DC Master Assignment Interface Unit

The F16 is a simple 1U rack mount unit designed to interface the 
analogue voltages of a Cadac console’s DC Master faders to the 
digital control environment of the D16. An additional feature of the 
F16 enables D16 integration with select third-party consoles or cus-
tom built third-party control interfaces. 

NOTE: The F16 is shipped from the factory with rubber feet 
mounted on the underside of the chassis. These are fixed to 
the chassis via adhesive and can be removed if necessary. 
Removal is a simple process of peeling the feet off of the base 
of the F16.

Input Range

Cadac
The Cadac input setting is optimised for connecting to the DC Mas-
ters of a Cadac console. The voltage ranges from -0.33v when the 
fader is at +10dB to 0V when the fader is at 0dB. At -20dB the volt-
age is +0.66v and >+4v when the fader is at infinity.

G.P.
The G.P. (General Purpose) input setting is intended for third-party 
and custom build control interfaces. It expects a voltage that varies 
from 0v to +5v with +4.5v corresponding to 0dB. This may be 
changed by using the Calibrate function.

Calibration
In each mode the 0dB point may be calibrated for extra accuracy, as 
follows:

■ Make sure the unit is set to the required input mode (Cadac or 
G.P.) and is connected to the console, or other control device.

■ Switch the F16 unit OFF.

■ Switch ON the F16 whilst pressing in the INPUT button. The 
INPUT LED should flash.

■ Release the INPUT button and set all DC Master faders to 0dB.

■ Press and release the INPUT button. The INPUT LED should 
stop flashing. The unit is now calibrated, removing any residual 
dc offsets due to component tolerances and cabling.
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Operating Modes

Master
The Master mode enables the F16 to connect directly to one, or 
more, D16 units without the need to enumerate communications 
addresses.

NOTE: The Comms and Error LEDs do not operate in Master 
Mode.

Slave
This mode is not implemented.

Connectors

The rear panel is equipped with the following connectors:

XLR Male and Female
These connectors provide the Cadac RS-485 communications bus 
on XLR connectors. They are labelled RS485 to indicate that they 
are NOT audio connections.

Remote Control
This 15-way female ‘D’ type connector provides the same RS485 
communications bus as found on the XLR connectors described 
above. The XLR and ‘D’ type connectors are wired in parallel.  

The pins used are:

Pins 1,2,9 and 10 Ground
Pin 11 Comms+
Pin 3 Comms-

NOTE: Cadac can supply cables (cost option) to enable multi-
ple D16s to daisy-chain directly to the F16 Remote Control ‘D’ 
type connector. Please contact your nearest Cadac distributor 
for further information.

WARNING: Do not attach wires to any other pins as their func-
tion in the D16 may be reserved by Cadac and may carry inap-
propriate voltages.
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Fader Bus and Data Bus A Connections

These two 25-way female ‘D’ type connectors are designed to plug 
directly onto the identically named connectors on the back of a Cadac 
J-Type console where they gain access to the DC Voltages generated 
by the console’s DC Master faders and other logic functions.

NOTE: Only voltage control has been implemented at this time and 
therefore it is only necessary to connect the Fader Bus to the con-
sole.

NOTE: Other Cadac consoles can also connect directly to the 
Fader Bus connector and Cadac can supply suitable cables for 
this purpose (cost option.) Please contact your nearest Cadac 
distributor for further information.

Other control devices may be used if they are wired to these con-
nectors in an appropriate way and if they generate suitable control 
voltages (see  Input Range)

F16 Fader Bus Connector Wiring 

Pin 1 GND

Pin 6 DC Input 161

Pin 7 DC Input 7
Pin 8 DC Input 6
Pin 9 DC Input 5
Pin 10 DC Input 4
Pin 11 DC Input 3
Pin 12 DC Input 2
Pin 13 DC Input 1
Pin 18 DC Input 8
Pin 19 DC Input 9
Pin 20 DC Input 10
Pin 21 DC Input 11
Pin 22 DC Input 12
Pin 23 DC Input 13
Pin 24 DC Input 14
Pin 25 DC Input 15

Other pins on the Fader Bus connector and the DATA Bus A con-
nector are reserved for future use by Cadac.

NOTE: Cadac Electronics PLC is not responsible for any dam-
age caused to the F16, or any other piece of equipment, if 
incorrect voltage levels are applied to these connectors.

1. This pin is “not-connected” on the Cadac J-Type but it is included here for comp
bility with the Cadac R-Type console, which has 16 DC Master faders, and with 
third-party units that provide 16 control faders.
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F16 Software Version

To check the software version of the F16 press and hold the MODE 
button for 3 seconds. Both the MASTER and SLAVE LEDs will flash 
and the Fader Open LEDS will display a 16-bit binary number.

Software versions are usually defined as a number such as V1.23 
where the pre-decimal point digit(s) are incremented for major 
changes to the software and the post-decimal digits are incre-
mented for minor changes to the software.

The Fader Open LEDs 9-16 represent the pre-decimal point digits 
and LEDs 1-8 show the post-decimal point digitals. If the software is 
a BETA test version then Open LED 16 will be illuminated. BETA 
software should only be used with express permission from Cadac 
or their authorised distributor. 

The following illustration shows how V1.23 would appear.

Press the MODE button again to exit the Version Display Mode and 
return to normal operation.

NOTE: The initial pressing of the INPUT button to enter this 
mode may change the Communications Mode from MASTER to 
SLAVE or vice versa. Make sure the unit is operating in the cor-
rect style after exiting from the Version Display Mode.
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Warranty

Dear Customer,

We thank you for having purchased this CADAC product and hope 
you will have many years of service from it.

Your CADAC product is warranted for a period of 12 months from the 
date of original purchase to be free from defects in material and 
workmanship. In the event that the product proves defective and re-
quires service within the 12 month warranty period, CADAC, or its 
appointed distributor will, without charge for labour or parts, repair or 
(at CADAC’s discretion) replace the product or its defective parts 
within the terms and conditions set out below.

Conditions

The warranty is valid only at the premises of the manufacturer, or the 
authorised distributor, and is provided on a pre-paid RTB (return to 
base) basis.

This warranty will not reimburse nor cover damage sustained as a 
result of modification that have been made to the product without the 
prior written consent of CADAC.

The warranty does NOT cover any of the following:

■ Transport costs and all risks of transport relating directly and 
indirectly.

■ Damage resulting from misuse, including but not limited to:

a) failure to use the product for its normal purpose or in accord-
ance with instructions detailed in the User manual.
b) installation or use of the product in a manner inconsistent with
national technical and safety standards in force.
c) improper or incorrect installation of software.

■ Repair made by the customer himself or a non-authorised repair 
company.

■ Accidents, lightning, water, fire or improper ventilation or any 
cause beyond the control of CADAC.

■ Defects in the system into which this product is incorporated.
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